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GasMix software 

1.1 Introduction 

1.1.1 What is GasMix? 

The GasMix program is software for calculating gas mixing ratios and also 

equilibrium compositions resulting from gas mixers such as the ProGasMix. However, 

the program has flexibility of configuration and use that makes it useful also for other 

gas mixing applications.  

1.1.2 History of GasMix – past and present 

The GasMix for Windows is a development from the GasMix program written by 

Truls Norby for HPBASIC computers in the 1980s and used in his group at University 

of Oslo till this date for calculating gas mixtures on gas mixers analogous to the 

ProGasMix. 

At present, the new GasMix software that you here are reading about and perhaps are 

trying out, is in its early development. This means that 

• Some functions of the program aren’t implemented yet. 

• The chance of bugs and incorrect calculations is considerable. 

• User friendliness and ease as well as screen information are not optimised. 

• This manual is in the midst of being written; it may have parts where the 

intended sections are missing or uncompleted. There may be minor errors in 

references to menus etc. in the program. 

• My apologies! Your comfort is that it can only get better and that it is free! 

Look for updates at http://folk.uio.no/trulsn/gasmix.htm 

1.1.3 GasMix emulates but does not control your mixer 

To avoid any misunderstanding: GasMix emulates the physical gas mixer and makes 

calculations based on the readings taken from the mixer. It is however not physically 

connected to the mixer in any way, it does not communicate with the mixer and it 

does not control the mixer in any way. 

1.2 Installation and startup 

1.2.1 GasMix package 

The GasMix software package consists of 6 files: 

GasMix.exe  The program itself 

GasMix Manual.pdf This manual (may also be integrated in another manual, e.g. a 

ProGasMix Manual.pdf) 
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Four parameter files, containing data for GasMix definition and calibration:  

GasMix.inp Input gases definitions 

GasMix.mix Mixer setup 

GasMix.cal Flowmeter calibration 

GasMix.cel Output cell setup 

1.2.2 Copy to directory c:\Program Files\Gasmix\ 

The package may be installed anywhere on your Windows computer. However, we 

suggest that you install it a directory  

c:\Program Files\GasMix\ 

If it does not exist, create it, and copy all GasMix package files there. 

1.2.3 Make a shortcut 

Point at the Gasmix.exe icon. Right-click and Create Shortcut. Move the shortcut to 

your desktop or elsewhere. Rename it e.g. “Shortcut to GasMix”. 

1.2.4 Start and run the program: GasMix.exe 

Start the program GasMix.exe from the shortcut icon or in any other way. Go to 

Section 1.3 for a quick-start introduction and tutorial or to Section 1.5 for a more 

thorough treatment of the GasMix definitions, capabilities, and operation.  

1.2.5 Updates 

If you later download or otherwise receive updates of the program, manual or 

parameter files, simply overwrite the existing ones. Consider, however, to make a 

copy of all existing files in a separate directory in case the original or edited 

parameter data will be needed or the new program version does not work on your 

computer for some reason. 

1.3 GasMix quick-start and tutorial 

This section intends to give the user a fast introduction to the GasMix software and 

practice in using it. For deeper definitions, specifications and explanation, refer to 

Section 1.5.  

1.3.1 Start and run the program: gasmix.exe 

Start the program GasMix.exe from the shortcut icon or in any other way. 
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1.3.2 Overview of the gas mixer and GasMix display 

At the bottom of the display are a row of small boxes, each representing an Input gas. 

Typical Input gases are the pure gases or mixtures that come from bottles or lines of 

gas in your laboratory, e.g. O2, Air, N2, Ar, 5% H2 in Ar. 

Next – at middle height of the display - comes a row of vertical rectangles, 

representing the Flowmeters. Some of the Flowmeters may be fed from the Input 

gases, and this is then illustrated by coloured connecting lines – one colour for each 

Input gas. 

Above the flowmeters gas lines show how the flowmeters are connected to form 

Mixtures. Each Mixture has a colour, and there is one small boxes attached to the 

Mixture line above the first flowmeter connected to that Mixture. 

Additional small boxes directly below or above a flowmeter represent stages for 

fixing the partial pressure of some component, normally H2O (wetting or drying 

stages). 

On the top you find rectangles representing your measurement or reaction chambers, 

here called Output cells, for which temperature and total pressure can be set so as to 

allow calculation of equilibrium partial pressures. 

The right hand side of the window is reserved for tables in use during editing and data 

entry. Moreover, results of mixing and equilibrium calculations will appear on the top 

of the window.  

During editing of calibration curves also parts of the mixer schematic temporarily 

becomes covered with tables and graphs. 

1.3.3 Run a simple session with typical actions 

Load a set of parameter files to define everything. In the menus, go to File menu and 

select Open All. A file dialog allows you to find the location of the setup files (*.MIX, 

*.CAL, *.CEL, and *INP). Click on one of them, and all (up to four) that are found 

with the same first part of the filename are loaded. 

If the mixer that appears has something in at least one of the input mixture boxes at 

the bottom, and something in at least one flowmeter box at middle height, and lines 

making some connections between input mixtures and flowmeters and further to an 

output cell at the top, the mixer appears to be configured with a real or tutoral 

example and should be ready to do something. In that case, leave the Edit menu 

unused for the moment. 

Select FlowmeterReadings in the top menu. A table appears where you edit the 

readings of flowmeters. If the readings look sensible, leave them, or change one just 

for the test. Or you may enter for instance 3 as a reading for all flowmeters. Press the 

OK button. The edited readings should now be visible at the bottom of the flowmeter 

boxes. 

Select Execute in the top menu. Now the program makes all calculations of mixtures 

and displays them in a table for output cells and partial pressures of gas species. 

In the Settings menu change the display from linear to logarithmic.  

There is also a possibility to change between room temperature contents and 

equilibrium values. Equilibrium calculations are not correctly operating yet. 



Preliminary GasMix Manual, v. 0.301    07.02.2010                                     

 6 

You may now go on doing more things, or minimise the program, or exit from File, 

Exit.  

1.4 GasMix operations in more detail 

1.4.1 Edit the input mixtures 

With input mixtures is meant what you may often call gases – the gases that are 

supplied to the mixer from pressured bottles or lines. They are actually generally 

mixtures, firstly because some of them are, such as air or hydrogen that is diluted with 

an inert gas to make it explosion safe. Secondly, even simple gases contain impurities, 

and these may be entered into the input gas and makes it a mixture.  

Start editing input mixtures by Edit, InputMixtures. 

Next to the table that appears, the name of the input mixture s entered in the separate 

window. This name has no meaning other than to identify the input mixture. If it is 

oxygen 99.99 %, then you may for instance call it O2 or Oxygen or O2-4N. 

In the table itself, enter the names of the gas species and their content pairwise in the 

two columns. The name must be exactly the same as the one used in the calibration 

curves, and normally also exactly the same as the program uses for equilibrium 

calculations. Typically valid names are O2, N2, Ar, H2 and H2O. Names should here 

not reflect a mixture. (For instance Air is not meaningful here.)  

The gases contained in the input mixture may be entered in any order. 

The units of content may be any as long as it is consistent for each input mixture. The 

program only uses the partial pressure calculated as the content divided by the total 

content.   

Note that water (H2O) may be entered as an impurity in an input mixture, but water as 

such is normally not entered as an input mixture – it comes in via humidification 

stages. 

1.4.2 Edit the flowmeters and gas mixer configuration 

Start editing flowmeters and their configuration by Edit, Flowmeters. 

Go to the appropriate flowmeter by using the up/down controls. Edit the table. 

Remember to press OK before proceeding to the next flowmeter. The mixer layout 

scheme changes only upon pressing the OK button.   

All information regarding the make, type, and float of a flowmeter is edited here. 

Remember that exact spelling is required for the calibration curves to recognise the 

flowmeter. (The actual flow reading is not edited here, but in a special table accessed 

directly from the FlowmeterReadings menu point.) 

Moreover, it is specified what gas mixture the flowmeter is supplied with. This is 

done by writing I # (where # is a number) for Input Mixtures, and M # for mixed 

Mixtures. 

It is also specified which mixture the flowmeter feeds to, numbered simply from 1 to 

16. Note that the box specifying the mixture and its total flow is placed after the first 
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flowmeter only (for practical reasons) while it actually signifies all the flowmeters 

going into that mixture. 

Finally, you can here specify Fixed gas pressure units – normally simply 

humidification or drying units. For this, the gas species to be fixated, the method, and  

the temperature (when relevant) are specified. In addition, the use of the unit can be 

switched between Yes and No, and you specify whether it is placed before or after a 

flowmeter. 

For humidification, let the gas be H2O and the method be Pure or KBr, and set the 

temperature to that of the humidification step – equal to the room temperature if you 

have no special reading or thermostat. For drying, let the method be Dry. 

Note that when you press OK to confirm the changes made to a flowmeter, the mixer 

scheme changes on the screen.  

1.4.3 Edit the output cells 

Start editing flowmeters and their configuration by Edit, OutputCells. 

Select which mixture to feed the cell. 

Give the impurity/background levels of gas species you consider appropriate to add to 

the final gas mixture fed to the cell. The source of these may be typical leakages, 

permeable gas line hoses, permeable high temperature cell wall materials, desorption, 

or impurities in the input mixtures not specified other places. The gases species you 

can add impurity or background levels to are O2, H2O, H2, and N2. For single walled 

high temperature cells we suggest O2 = 1E-5 (10 ppm) and H2O = 3E-5 (30 ppm) as 

realistic settings (with H2 and N2 zero). 

Select the cell’s temperature and pressure if used for equilibrium calculations..   

Press OK to confirm the changes. 

1.4.4 Edit the calibration curves 

GasMix can store up to 1000 flowmeter calibration curves. 

Each curve can hold up to 20 data pairs (reading, flow). 

All curves must have the same unit for readings. The default – and the unit used in the 

calibration curves supplied as standard with GasMix – is litres/hour (l/h). Litres here 

of refers to standard litres (1 atm, 25 °C). 

Start an editing session from Edit, Calibration. 

The numerical data are entered in the right hand table.  

The data MUST be entered in increasing order of Reading. You do not need to use all 

20 rows, but the last rows not used must hold only 0,0. 

In running the program, readings below the lowest or above the highest valid 

calibration point are rejected.  

The first entry may have a reading of 0, but 0 is anyway always interpreted as zero 

flow. Any value larger than zero is then interpreted in the normal manner.  
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If the lowest reading is larger than 1 (e.g. 2) then 1 is given a special meaning, namely  

to represent the maximum flow. The use of this will be dealt with later on. 

You may enter data manually one by one, or you can copy them via the clipboard for 

instance from Excel. In order to do this, first go to Excel and mark and Copy a section, 

e.g. the Readings column. Then go to GasMix and press the first cell, then mark all 

cell in the range you need while holding the Shift key down. Then Right-click inside 

this range and select Extract from Clipboard. 

As you make the calibration curve, check that it looks as expected from the plot that is 

displayed based on the numbers you enter. 

For each calibration curve filled with numbers you must press the OK button to store 

the data in memory, otherwise the entered numbers are lost. (This is a safety against 

unintended data entry in established curves.) 

The data specifying the flowmeter and conditions for each calibration curve is entered 

in the left hand side table. Note that the texts entered must be accurately the same as 

those used for flowmeters are gas species. A misprint means that the program will not 

recognise the fit of the calibration curve to the flowmeter or gas.  

In this table, you can enter data for several curves, but you must press the OK button 

in order to store the changes in memory. If you go to another operation without 

pressing OK, the changes are lost.  

1.4.5 Edit the flowmeter readings 

The flowmeter readings are entered from FlowmeterReadings. Press OK to confirm. 

1.4.6 Execute the calculations 

Select Execute to do all calculations throughout the mixer. The result is shown in a 

table where all gas species appear for all Output Cells. 

The composition of a mixture is not shown unless the mixture is routed to an output 

cell. 

1.4.7 Settings: Change the display of the output 

In the Settings menu you can change between linear and logarithmic display of the 

gas partial pressures of the mixtures; lin/log toggle. 

Moreover, you can select whether the room temperature mixture as fed to the output 

cell or the equilibrium composition is displayed. The equilibrium display will show 

only species well defined by their thermodynamics in the program and where the 

required chemical elements are all present in the mixture fed to the cell. The 

equilibrium option is not operative yet, and you will only get a warning if you try it.   

1.4.8 Error messages 

There is a field for warnings and error messages – in red at the bottom of the screen. 



Preliminary GasMix Manual, v. 0.301    07.02.2010                                     

 9 

1.4.9 Display 

You may drag and resize the GasMix window, and maximise/minimise it. In some 

cases, resizing is a way to refresh the GasMix display if parts are not showing. 

If you cannot see all items on screen, it is possible that your screen has a too small 

resolution. This is mostly a problem with video projectors or small laptops or old 

computers.  

1.5 GasMix technical reference 

1.5.1 GasMix capabilities and definitions 

The GasMix program comprises a number of components and connections between 

them, to be described below. 

Those that are user editable are accessed through the Edit menu.  

1.5.1.1 Gas species  

A number of gas species (atoms or molecules) are predefined in the program. They 

are identified by their chemical formulae: H2, N2, O2, Ar, H2O, CO, CO2, etc. 

Thermodynamic parameters of formation are connected with these species. These 

definitions and parameters can not be edited by the user.   

1.5.1.2 Input Gases 

Up to 16 input gases can be named and defined by the user, corresponding to the 

gases connected to the inputs of the mixer. Each input gas is actually a mixture of gas 

species, and the definition is simply a fractional content of the gas species.  

The definitions of the input gases can be edited via Edit, Input Gases. 

The definitions of the input gases can be stored in files of type *.inp via the File menu 

and submenus.  

1.5.1.3 Flowmeters and mixer configuration 

Up to 16 flowmeters can be defined by the user. They are supposedly rotameters and 

thus identified by their make, model, tube size, and float material, but the make, 

model, and size can also be used to identify any other type of flowmeter. The 

definitions of the flowmeter will enable the program to find a suitable calibration 

curve when the flow is to be calculated. 

Each flowmeter can be configured so as to feed any of 16 Mixtures. Further, each 

flowmeter can be configured so as to be fed from any of the Input Gases or Mixtures. 

Each flowmeter can be configured with a gas fixing stage before it or after it. A gas 

fixing stage fixes the partial pressure of one gas component. Usually, this is a stage 

for H2O which wets or dries the gas to a certain level. Various ways of operation and 

calculation can be set, and the temperature of operation also enters.  

All these definitions set up the overall connection and mixing scheme of the mixer. 

The connections are shown graphically on the program screen. 
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The definitions of the flowmeters, fixing stages, and connections of the mixer can be 

edited via Edit, Flowmeters. 

The definitions of the flowmeters, fixing stages, and connections of the mixer can be 

stored in files of type *.mix via the File menu and submenus. 

1.5.1.4 Calibration curves 

Up to 1000 flowmeter calibration curves can be held by the program. They can be 

entered in any order. They are marked with the flowmeter name, tube size, float 

material, gas, individual flowmeter, temperature, and pressure that the calibration is 

valid for. Further, each curve contains up to 20 data points. The program selects the 

best curve available for any flow calculation. 

The calibration curves can be entered or edited via Edit, Calibration. 

The calibration curves can be stored in files of type *.cal via the File menu and 

submenus. 

1.5.1.5 Output Cells 

Up to 8 output cells may be defined, normally the measurement cells at high 

temperatures to which gas mixtures are routed and for which equilibria are calculated. 

The cell can be assigned a gas mixture, total pressure, and temperature. In addition, 

leakages of H2, H2O, and O2 can be set that will be added to the Gas Mixture 

arriving.    

The definitions of the output cells can be edited via Edit, Output Cells. 

The definitions of the output cells can be stored in files of type *.cel via the File menu 

and submenus. 

1.5.2 Parameter files 

1.5.2.1 File definitions 

The GasMix parameters are stored in four types of files according to the part of the 

mixer and parameters affected. The types have indicative extensions:  

 *.inp Input gas definitions 

 *.mix Mixer configuration 

 *.cal Flowmeter calibration curves 

 *.cel Output cells 

1.5.2.2 File operations 

The File menu allows the user to open or save files individually. They may then have 

individual names. Alternatively, they may all be opened or saved in one operation 

using one and the same name for all.  

If one chooses the Open, Save, or Save As options, then a second level allows the 

selection of operation on one of the Input Gas, Flowmeters (Mixer), Calibration, or 

Output Cell parameter file. In this way, files with different names may be used for the 

different parameter sections. 
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If one chooses Open All, Save All, or Save All As, the operation will affect all four 

types and they will all address files by one and the same name (except the extension). 

In this way, entire sets of parameters may be opened or saved more easily. 

1.5.3 Calculations 

1.5.3.1 Flow of a mixture of gas species through a flowmeter 

When a mixture is passed through a flowmeter, the program calculates the flow of 

each gas species as if it was alone. Then its contribution to the total flow is obtained 

by multiplication by the partial pressure of the gas. By summation, the total flow is 

obtained. (There are other and more correct ways of doing this, and these may be 

implemented in future versions.)  

Finally, each gas species gets a partial flow by multiplying the total flow by its partial 

pressure, and this flow is added to the total flow of the mixture. 

It may be noted that a minor component of a gas in this way will be carried onwards 

by the mixture and would be carried onwards also in the calculations of its partial 

flow even if this species was not specifically calibrated for and therefore did not get a 

flow assigned to in the calculation of its contribution to the total flow. However, the 

way GasMix works, any gas will have a partial flow contribution calculated, using 

another gas’ calibration curve if necessary. 

1.5.3.2 Flow of a single gas species through a flowmeter 

When the calibration curve is selected the flow of each gas species is calculated from 

the flowmeter reading and that curve by using a Lagrange interpolation routine. 

Readings above the maximum calibration point are not accepted. 

Readings below the minimum calibration point are not accepted, with the following 

exceptions:  

The reading 0 (zero) always returns zero flow, even if the extrapolation of the curve 

gives another value or even if the calibration curve contains the reading 0 as the first 

entry and the flow associated with it is not zero. 

If the minimum reading of the calibration curve is bigger than 1 (one), then the 

reading 1 is taken to mean the same as the maximum reading. The experienced user 

can use this for fast entry of readings in parts of the mixer where the actual flow does 

not matter (no mixing) and it is desirable to just tell the program that gas is running in 

plenty through the flowmeter. 

1.5.3.3 Selection of a calibration curve 

The conversion of a flowmeter into a flow requires a calibration curve. The program 

can hold a large number of calibration curves, and attempts to find the one best suited. 

At present the algorithm used is the following: The program looks for matching 

flowmeter make, flowmeter type, float type, gas species, and actual flowmeter. The 

one with the closest match is chosen. Normally, with standard curves, it will be easy 

to achieve the first four. To get the fifth it is assumed that you will have made 

individual curves for individual flowmeters of your mixer. 
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In future versions of the program it is planned to make the selection more advanced 

and safer, and to display and verify the selection. Moreover, more advanced manners 

of obtaining flows of mixtures instead of individual gas species may require different 

selection criteria.     

1.5.3.4 Making mixtures 

The partial flows from all flowmeters connected to a Mixture are calculated and 

added. When all are done, the program divides the individual partial flow of each 

species with the total flow to obtain the fractional content. If the total pressure is one, 

the fractional content will correspond to the partial pressure.    

1.5.3.5 Fixation of a gas species 

When a gas mixture passes a fixation stage, e.g. a wetting or drying stage, the new 

mixture is calculated according to the following principles: 

Before the fixation stage, each gas i has a partial pressure pi,b and the sum of all these 

is Ptot,b. After the fixation stage, gas j has had its partial pressure changed from pj,b to 

pj,a. This change may be positive (as in a wetting stage) or negative (as in a drying 

stage). All the other gases i ≠ j will have to share a corresponding decrease or increase 

in partial pressure, so as to arrive at a sum of the partial pressures pi,a of all gases i 

corresponding to the total pressure after the stage, Ptot,a. 

If the total pressure is the same both before and after the fixation stage, the partial 

pressures after the fixation are 
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If the total pressure is unity, as in the present version of GasMix, then this simplifies 

further into  
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If the fixation stage is inserted before a flowmeter, the new composition is first set, 

and the flow then calculated using the composition with the calibration of the 

flowmeter to obtain the total and partial flows. 

If the fixation stage is inserted after a flowmeter, the new post-fixation composition of 

the fixated gas and its new partial flow is calculated, and the new total flow and 

individual composition of each of the other species are calculated based on the 

increase or decrease in content of the fixated gas. The formulae used for the 

composition is the same as used above for pre-flowmeter fixation.  

1.5.3.6 Calculations of fixed pressures for various gases and methods 

The fixed pressure of water over pure water H2O (method “Pure”) is calculated with 

the Goff-Gratch equation, with temperature as input. 

The fixed pressure of water over a saturated solution of KBr(aq) (method “KBr”) is 

taken as 84 % of that calculated by the Goff-Gratch equation. This percentage is 

specified in the CRC Handbook for 20 °C. 
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The pressure of water over a drying or getter stage (method “Dry” or “Getter”) is set 

to zero. 

The pressure over pure heavy water D2O is calculated from the 5
th

 order polynomial 

formula  

pD2O (kPa) = 0.413333333 + 0.046428671*t + 0.000936772*t
2
 + 2.85781e-05*t

3
 + 

2.5e-07*t
4
 + 2.82051e-09*t

5
 

where t is the temperature in degrees Celsius. The curve is based on a fit using 

TableCurve 2D to values taken from the CRC Handbook
1
. 

The pressure over D2O saturated with KBr is tentatively calculated as 84 % of that 

over pure D2O.  

The pressure of oxygen over a getter stage (method “Getter”) is set to zero. 

The Method names are case insensitive. 

1.5.4 Definitions of arrays and indexing used in the program 
(mainly for programmers) 

1.5.4.1 Chemical Elements 

The elements are numbered and named according to their atomic number and 

chemical formula. For instance, hydrogen is 1, H, helium is 2, He, etc. 

Deuterium is given the number 122 and formula D, and tritium is given the number 

123 and the formula T. No other isotopes are handled as such.  

1.5.4.2 Compounds and gases 

GasMix operates with predefined compounds, for which thermodynamic data are 

stored and their elemental compositions are defined. They are used in calculations of 

equilibria. They are indexed by an arbitrary number and identified by their chemical 

formulae. Any well-defined single phase can be what is here called a compound. 

Examples comprise monoatomic elemental gases (He, Ar), molecular elemental gases 

(H2, O2, O3, N2), gaseous compounds (CO, CO2, H2O), and condensed phases such 

as solid graphite (C). 

GasMix furthermore operates with gases. These are gaseous species – in one sense the 

same as gaseous compounds. However, they need not in principle be defined 

thermodynamically – it is more important in the first instance that the flowmeters are 

well calibrated for them in order to obtain correct mixing ratios. If equilibria are 

required however, only gases corresponding to a defined compound (as above) can be 

properly split into the proper amount of defined elements. The remaining will enter as 

inert.  

1.5.4.3 Mixtures  

GasMix stores gas mixtures in a number of arrays, depending on where in the mixing 

and calculation process they are: 

                                                 
1
 Handbook of Chemistry and Physics, 73

rd
 Edition, Lide, D.R. Ed.; CRC Press: Boca Raton 1992; 

Chapter 6, pg. 10 
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The InputMixtures array hold all input mixtures – they can be opened from and saved 

to *.INP files. They can be edited by the user. They are copied into the Mixtures array 

when a calculation is initiated. 

The Mixtures array is an array that holds input mixtures and mixed mixtures alike. It 

is rearranged in the course of mixing so that all mixtures have the same order of gases. 

The Mixtures feed the flowmeters and the output cells. The Mixtures array holds only 

room temperature mixtures, it does not contain equilibrated mixtures. 

CompBuffer is a temporary buffer array for the gas species and is used during the 

calculations of partial flows and setting of fixed gas for each individual flowmeter. 

The CellMixturesRT array is similar to the other mixtures, but holds the room 

temperature mixtures in the output cells. It is copied from the Mixtures array after 

completion of all calculations in the mixer, and in addition gets the leakages of the 

gases specified for the individual cell. 

There are additionally arrays for equilibrium calculations and equilibrium pressures. 

These have CellMixturesRT as input and will be described when the equilibrium part 

is operative.     


